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Worum geht es?
Als Immobilienberatungsfirma besteht unser Kerngeschäft darin, Personen oder Unternehmen das optimale Objekt zu vermitteln. Dabei orientieren wir uns natürlich an den Wünschen der Kundschaft, weshalb wir zuerst bei jedem Kunden eine Bedürfnisabklärung vornehmen.
Die Bedürfnisabklärung mit unseren Mitarbeitern hat zu folgendem Ergebnis geführt:
1. Unser Kunde ist elektrosensibel, d.h. Stromleitungen der Eisenbahn und die Umgebung von Mobilfunkstationen sollten möglichst gemieden werden.
· Ausserdem wünscht er sich möglichst wenig Lärm.
· Er möchte gerne die ÖV benutzen.
· Eine Hanglage mit guter Aussicht und südlicher Exposition wäre sehr wünschenswert
· Das Haus oder die Wohnung soll in der Region Baden-Wettingen liegen.


Die Geodaten
Um diese Analyse mit GIS vorzunehmen, braucht es Informationen über die betreffende Region. Man muss das Relief und die Lage der Stromleitungen usw. in Baden-Wettingen möglichst exakt kennen. Diese Informationen müssen in digitaler Form – also als Vektor oder Rasterdaten – vorliegen.
Wie kommt man zu diesen Daten? Informationen über das Relief der Erde liefern uns Satelliten, welche das Gebiet überfliegen und Höhenmessungen der Topographie liefern. Diese Daten werden per Funk auf die Erde übermittelt und in digitale Höhenmodelle (dhm) umgewandelt. Dabei handelt es sich um Rasterdaten.
Über die Landnutzung führen in der Regel vor allem die Gemeinden und auch der Kanton buch. Die Gemeinden erstellen und verwalten ihre eigenen aktuellen Zonenpläne (z.B. Bauzone, Landwirtschaftszone, Wohnzone usw.). Dabei handelt es sich um Karten oder Pläne, welche heute praktisch alle in digitaler Form erhältlich sind. Die Gemeinden sind ihrerseits verpflichtet diese Geodaten dem Kanton bereitzustellen. Der Kanton erhebt auch selber noch weitere Geodaten die von kantonalem Interesse sind (z.B. Naturschutzgebiete, Kantonsstrassen, Grundwassernutzung) und verwaltet alle Datensätze zentral (AGIS = Aargauische Geographische Informationsstelle).
Für diese Übung müssen wir und um die Datenverwaltung nicht mehr kümmern. Die Zahlensätze über das Relief und die Landnutzung stehen uns in digitaler Form (vom AGIS) zur Verfügung:
1. Digitales Höhenmodell Baden-Wettingen: 1060_DHM25 Matrixmodell (Rasterdaten)
· Mobilfunkantennen (Punkte): gsm_236_20010911 (Vektordaten)
· Eisenbahnlinen (Linien): xeis_453_20040525 (Vektordaten)
· Bahnhöfe (Punkte): bhof_944_20011101 (Vektordaten)


Die Fragestellung (raumrelevante Kriterien)
Aus den Kundenwünschen können wir also zum Beispiel folgende raumrelevante Kriterien für die Suche nach einem idealen Standort für das Haus oder die Wohnung ableiten. Wir suchen ein Gebiet (oder mehrere Gebiete) die folgende Kriterien möglichst gut erfüllen:
1. liegt in der Region Baden-Wettingen
· Ist möglichst südexponiert
· Hanglage ist erwünscht
· nicht in der Nähe von Mobilfunkantennen
· nicht in der Nähe von Eisenbahnlinien
· in der Nähe einer Bahnstation
· ev. nicht in der Nähe einer grösseren Strasse

[image: ][image: ]Grundsätzliches
In dieser Übung werden wir die Eignung eines Gebietes in Bezug auf raumrelevanten Kriterien (z.B. Nähe zum Bahnhof, Südexposition usw.) bewerten.
Das Resultat dieser Analyse wird wieder ein Rasterbild (d.h. eine Karte bestehend aus einzelnen Pixel) sein, aus welcher sich die Eignung des Gebietes ablesen lässt. Man nennt diese neue Karte auch „Eignungskarte“ und den Prozess „Multikriterienanalyse“.
Das Vorgehen ist analog zur Berechnung von Zeugnisnoten. Jedes Kriterium entspricht einer Prüfung, welche benotet wird mit einer Skala (z.B. 1 bis 6). Für das Zeugnis wird dann der Notendurchschnitt berechnet, wobei die einzelnen Prüfungen gewichtet werden können, wie bei halb oder doppelt zählenden Noten.
Der prinzipielle Ablauf ist folgender:
A.	Notenskala definieren
Wir definieren welche Werte (Noten) unsere Eignungskarte enthalten soll (z.B. 1 bis 6).
B.	Eignungskarte pro Kriterium (Kriteriumskarten)
Wir vergeben z.B. für die Distanz 0-100 m zum Bahnhof die Note 6 für 100-200 m die Note 5 usw. Die Karte enthält nur noch Werte von 1 bis 6. Je eine Karte pro Kriterium.
C.	Eignungskarte für alle Kriterien (Eignungskarte = Lösungskarte)
Wir erstellen die Eignungskarte für alle Kriterien – die Lösungskarte. Dabei wird der Durchschnittswert eines Pixels unter Einbezug aller Kriterien berechnet. Jedes Pixel erhält einen Wert (1 bis 6), welcher ein Mass für die Eignung des Gebietes darstellt. Wie bei Zeugnisnoten ist festzulegen, wie stark welches Kriterium ins Gewicht fallen soll.


Bevor Sie beginnen…–> Bearbeitungsgebiet festlegen
In aller Regel beschränkt man sich bei geografischen Fragestellungen auf ein bestimmtes Gebiet. Die Datensätze sollten daher vorgängig an die benötigten Ausschnitte angepasst werden, damit die Berechnungen beschleunigt werden und auch weniger Speicherplatz benötigt wird.
☞ Bei grossen Ausschnitten kann eine Berechnung aufgrund der Datenmenge mehrere Stunden benötigen!

A. Rasterdaten ausschneiden (Digitale Höhenkarte für Wettingen, Topographie von Wettingen)
· Add Layer > mmgr_20011228 (im Ordner 1060_DHM25 Matrixmodell, digitale Höhenmodell des Kantons Aargau in einer Auflösung von 25 Meter).
· Anzeige so einstellen (Lupe, Hand), dass nur der gewünschte Ausschnitt angezeigt wird.
· Fenster > Bildanalyse >  mmgr_20011228 aktivieren (leuchtet blau).
· Bildanalyse > Verarbeitung > Ausschneiden
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[image: ]Der berechnete Ausschnitt erscheint nun in der Anzeige als neue Rasterdatei mit dem Namen “Clip_mmgr_20011228“.
–> Achtung: Diese Datei ist nur temporär gespeichert, sie wird gelöscht, sobald ArcGIS ausgeschaltet wird. Die Datei muss gesichert werden. Dazu mit der rechten Maustaste auf den Namen klicken und Daten > Daten exportieren. Speichern Sie die Datei unter einem sinnvollen Namen an einem sinnvollen Ort.

[image: ]
Wichtig: Dieses Verfahren zur Auswahl und Abspeicherung eines Ausschnitts gilt für alle Geodaten im Rasterformat.

B. Vektordaten ausschneiden (Bahnhöfe der Region Baden-Wettingen)
Bei Vektordaten kann man mit dem „Features Auswählen“ Werkzeug die gewünschten Punkte, Linien oder Polygone auswählen und anschliessend aus diesen ausgewählten Objekten eine neue Karte erstellen. Die Schritte werden am Beispiel der Bahnhöfe für die Region Baden-Wettingen beschrieben.
· [image: ]Layer bhof_944_20011101 hinzufügen (Add Layier).
· Auf das „Features auswählen“ Werkzeug klicken, mit dem Pfeil ein Rechteck aufziehen und die gewünschten Features auswählen. Die ausgewählten Bushaltestellen erscheinen in hellblauer Farbe.
· Rechte Maustaste auf bhof_944_20011101 > Daten > Daten exportieren > Ausgewählte Features.
· Datei unter sinnvollem Namen an sinnvollem Speicherort abspeichern
· Datei dem Layer hinzufügen.

[image: ]
Wichtig: Dieses Verfahren zur Auswahl und Abspeicherung von einzelnen Objekten gilt für alle Geodaten im Vektorformat (Punkte, Linien, Polygone).

Eignungskarte erstellen: Wohnungssuche in Baden-Wettingen

1. Exposition (engl. Aspect)
Die Wohnung soll möglichst gegen Süden exponiert sein, denn Nordhänge sind in diesem Fall ungünstig, weil die Sonne weniger scheint und damit auch deutlich höhere Heizkosten anfallen können.
Wir lösen diese Aufgabe in zwei Schritten:
· Expositionskarte mit allen Expositionsrichtungen erstellen
· Daraus Kriteriumskarte erzeugen mit Werten von 1 bis 6

a) Expositionskarte erstellen
(Geoverarbeitung > Aspect)
Aus dem digitalen Höhenmodell erzeugen wir eine neue Karte, welche die Werte (Himmelsrichtungen) der Exposition des Geländes enthält.
Öffnen Sie den Ausschnitt des digitale Höhenmodells und starten Sie Geoverarbeitung > Aspect.
Füllen Sie das Dialogfenster so aus wie abgebildet. Der neuen Karte geben wir einen sinnvollen Namen (z.B. Exposwett) und speichern sie ab.
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[image: ]
Die Karte „Exposwett“ zeigt alle Geländeexpositionen im gesamten Gebiet an. 0 = Nord, 90 = Ost, 180 = Süd, 270 = West, 360 = 0 = Nord, -1 = flaches Gelände.

b) Eignungskarte der Expositionen
(Geoverarbeitung > Reclassify)
Wir müssen nun diese Expositionswerte „benoten“, d.h. wir ersetzen sie durch Werte von 1 bis 6. Man nennt diesen Vorgang „Reklassifizieren“, dabei liegt es an uns zu entscheiden, was mit 6, 5, 4 usw. benotet werden soll. In diesem Beispiel ist die Notenskala in der Tabelle unten rechts vorgeschlagen.
Starten Sie Geoverarbeitung > Reclassify. Füllen Sie das Dialogfeld so aus wie in der Abbildung (Notenwerte aus der Tabelle rechts).
Hinweis: Bei langen Tabellen wie dieser, macht es Sinn, die einmal erstellte Tabelle zu speichern (save Knopf drücken). Das erleichtert die Arbeit  bei späteren Änderungen erheblich. Speicherort beachten!
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Das Resultat ist eine Kriteriumskarte, welche nur Werte zwischen 1 bis 6 enthält. Wir geben der Karte einen sinnvollen Namen (z.B. recl_exposwett).


2. Hanglage
Eine gute Aussicht ist nur dann garantiert, wenn das Gelände entsprechend geneigt ist. Bei flachem Terrain kann man auch nicht von einer Exposition sprechen. Wir machen das in zwei Schritten:
· Neigungskarte mit allen Hangneigungen erstellen
· Daraus Kriteriumskarte erzeugen mit Werten von 1 bis 6

a) Neigungskarte erstellen
(Geoverarbeitung > Slope)
In einem ersten Schritt werden wir aus der digitalen Höhenkarte von Wettingen (1060_DHM25 Matrixmodell, Ausschnitt Wettingen) eine neue Karte erzeugen, auf welcher die unterschiedliche Neigung des Geländes eingezeichnet ist. Das erledigt für uns das Modul slope (Neigung).
Starten Sie Tools > Spatial Analyst Tools > Surface > Slope und füllen Sie das Dialogfenster so aus wie abgebildet. Der neuen Karte geben wir einen sinnvollen Namen (z.B. slope_wett).

[image: ]

b) Eignungskarte der Neigungen
(Geoverarbeitung > Reclassify)
Diese Karte zeigt die Geländeneigungen im gesamten Gebiet in Grad (Winkel) an. Interessant sind Gebiete, welche eine ausgeprägte Neigung aufweisen. Wir benoten diese Neigungswerte mit dem Tool Reklassifizieren. In diesem Beispiel ist die Notenskala in der Tabelle unten rechts vorgeschlagen. Wir erzeugen eine Eignungskarte der Neigungen, welche nur noch die Werte 1 bis 6 enthält. Tools > Spatial Analyst Tools > Reclassify Füllen Sie das Dialogfeld so aus wie in der Abbildung.
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Wir geben der neue Karte einen sinnvollen Namen (z.B. recl_slope_we).


3. Abstand zu Mobilfunkantennen
Da unser Kunde elektrosensibel ist suchen wir ein Wohngebiet, welches einen guten Abstand zur nächsten Mobilfunkantenne aufweist. Wir werden diese Aufgabe in folgenden Schritten lösen.
· Nur die Mobilfunkantennen der Region Baden-Wettingen auswählen (Vektordatensatz «236_Mobilfunk» reduzieren zu gsm_wett). –> Grundsätzliches S.2
· Pufferkarte erstellen, welche Gebiete in verschiedenen Abstandsradien um eine Mobilfunkantenne anzeigt. –> Ergibt eine Vektordatenkarte.
· Diese Vektordaten (Pufferkarte) in Rasterdaten umwandeln.
· Eignungskarte mit sechs Werten der Abstände zu Mobilfunkantennen erzeugen –> Rasterdaten!

a) Pufferringe um alle Mobilfunkantennnen der Region (nicht der ganze Kanton Aargau!)
(Geoverarbeitung > Mehrfachring-Puffer)
Fügen Sie die Vektordaten «236_Mobilfunkantennen» hinzu und wählen Sie nur diejenigen im Gebiet Wettingen aus!! Erzeugen Sie nun fünf Distanzen in Meter (=Pufferringe) um die Mobilfunkantennen Region: Geoverarbeitung > Mehrfachring-Puffer. Füllen Sie das Dialogfeld so aus wie abgebildet. Wir nennen die neue Karte gsm_wett_MultipleRingBuffer.
[image: ]

b) Pufferkarte (= Vektordatensatz) in Rasterdaten umwandeln
Geoverarbeitung > Feature to Raster. Datei als gsm_puff_rast speichern
Die Ausgabe-Zellengrösse gibt die Pixelauflösung des Rasters an. Hier habe ich 10 gewählt, das bedeutet, dass ein Pixel in der Realität 10 Meter x 10 Meter gross ist!
[image: ]

c) Eignungskarte der Abstände zu Mobilfunkantennen erzeugen
Wir benoten nun die Abstände wieder mit Reklassifizieren und erzeugen eine Eignungskarte der Abstände zu Mobilfunkantennen, welche nur noch die Werte 1 bis 6 enthält.
Geoverarbeitung > Reclassify. Füllen Sie das Dialogfeld so aus wie in der Abbildung. Speichern Sie die Datei (reclass_gsm).
[image: ]
Wichtig: NoData entspricht bei der Puffer Ringe Karte (Rasterdaten) denjenigen Gebieten, welche ausserhalb der Pufferringe liegen, in unserem Fall also weiter als 400 m entfernt sind. Diese Gebiete erhalten die beste Note, weil sie am weitesten entfernt liegen.


4. Abstand zur Eisenbahnlinie
Wir suchen ein Wohngebiet, welches einen guten Abstand zur nächsten Eisenbahnlinie aufweist. Diese Aufgabe ist in analoger Weise zu lösen wie das Problem der Mobilfunkantennen:
· Die Eisenbahnlinien der Region Baden-Wettingen auswählen (Vektordatensatz «xeis_453_20040525»). –> Grundsätzliches S.2
· Pufferkarte erstellen, welche Gebiete in verschiedenen Abständen um die Eisenbahnlinien anzeigt. Ergibt eine Vektordatenkarte.
· Vektordaten in Rasterdaten umwandeln.
· Eignungskarte mit sechs Abstandsnoten zu Eisenbahnlinien erzeugen

5. In der Nähe eines Bahnhofs
Wir suchen ein Wohngebiet in möglichst kurzer Distanz zur nächsten Bahnstation. Diese Aufgabe ist in analoger Weise zu lösen wie das Problem der Mobilfunkantennen, mit dem Unterschied, dass kurze Distanzen hier die höchste Note erhalten.
· Bahnhöfe der Region auswählen (Vektordatensatz «bhof_944_20011101») –> Grundsätzliches S.2
· Pufferkarte erstellen, welche Gebiete in verschiedenen Abständen um die Bahnhöfe anzeigt. Ergibt eine Vektordatenkarte.
· Vektordaten in Rasterdaten umwandeln.
· Eignungskarte mit sechs Abstandsnoten zu Bahnhöfen erzeugen, entscheiden Sie selber, wie Sie die „Benotung“ vornehmen wollen.
· 

6. Eignungskarte berechnen
Wir haben nun fünf Kriterienkarten (Rasterdaten) erzeugt, welche alle die Werte (“Noten“) von 1 bis 6 enthalten. Im übertragenen Sinne sind das die einzelnen benoteten Prüfungen. Im letzten Schritt werden wir diese Karten zu einer einzigen verrechnen (“Schlussnote“), welche uns die gewünschte Eignungskarte liefert. Dabei können wir den Kriterienkarten (“Prüfungen“) unterschiedliche Gewichtungen zuweisen.
In ArcGIS gibt es zu diesem Zweck das Modul „weighted overlay“ (gewichtete Überlagerung). Es berechnet den Durchschnitt aus verschiedenen Rasterkarten – unsere Kriterienkarten – und ermöglicht es den Kriterien eine Gewichtung in Prozent zuzuweisen.
· Laden Sie alle Kriterienkarten (reclExpos, recl_slope_we, recl_gsm, recl_xeis usw.) > add Layer
· Öffnen Sie das Werkzeug „weighted overlay“: Geoverarbeitung > weighted overlay
· Fügen Sie mit dem schwarzen Pluszeichen die Kriterienkarten hinzu
· Gewichten Sie die Kriterien in Prozent (Summe muss immer 100% sein!)
· Definieren Sie den Massstab in ganzzahligen Werten (From 1 To 6 By 1)
· Geben Sie einen sinnvollen Namen und Speicherort an.
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Schluss: Anzeige der Resultate
Wir präsentieren unsere Lösung dem Kunden mit einer anschaulichen Karte:
Eignungskarte öffnen (Add Layer) und mit Doppelklick auf die Farbkästchen die Farblegende anpassen (z.B. Grüntöne für 4,5,6, Gelb bis Rottöne für 3, 2, 1).
· Im Farbauswahlfenster auf Eigenschaften und dort auf Farbe ist null klicken. Die Lösungskarte ist nur noch in den geeigneten Gebieten eingefärbt (z.B. mit grün).
· Bahnhöfe der Region hinzufügen (bhf_wett) und Namen anzeigen lassen:
Rechtsklick auf Layer > Eigenschaften > Beschriftungen > Features beschriften lassen, ev. passendes Bahnhofsymbol aus der Symbolliste auswählen. (s. Abbildung):

[image: ]
· Eisenbahnnetz der Region hinzufügen (xeis_wett)
· Pufferringe der Mobilfunkantennen (Vektordaten) hinzufügen und unter Eigenschaften > Symbologie die Ringe einfärben (Alle Werte hinzufügen > Farbschema)
[image: ]

· Als Hintergrund eignet sich z.B. die Reliefdarstellung des dhm von Wettingen(Schummerung). Geoverarbeitung > nach Tools suchen > Spatial Analyst > Surface > Hillshade (Input Raster: dhm25_wett) Wählen Sie eine geeignete Reihenfolge der Layer und unter Eigenschaften sinnvolle Transparenzen.
	Geographische Informationssysteme (GIS)



Workflow Grafik des Modell zur Wohnungssuche in der Region Baden-Wettingen
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